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Overview
PhotoContest Pro is a program designed for Camera Clubs to run digital photo contests. The program 
manages the tasks of setting up a contest, managing the pictures for a contest, running and scoring 
the contest, assigning awards, viewing the pictures, and producing data reports.
 
The program license is assigned to a specific camera club. The program may be used by any member
of the club for use within the club only.
 
The entire process of setting up and running a digital photo contest is fully automated in PhotoContest 
Pro. The pictures are entered, managed, viewed, scored and assigned awards in a single program. 
The results are saved and can be used to generate reports. The pictures can be viewed and scored 
seamlessly together.
 
Setting up, running and scoring a photo contest is easy with PhotoContest Pro. The program is 
customizable for the requirements and scoring procedures of the specific club.

• Optimized image display
• Customizable contest display
• Customizable awards
• Customizable reports
• Single click end-of-season contests
• Support for multiple keypads for judging
• Total or average of judges scores
• Web-based picture submission

Web-based Picture submission allows individual club members to upload their own pictures into a club
contest through the Web; the tedium of entering all the pictures, titles and other information by the 
contest coordinator is gone.

Contest Results, Image Gallery, and Slide show applications that you can put on your club website to 
provide a dynamic image gallery and contest results from your scored PhotoContest Pro contests.

This manual describes the PhotoContest Pro program which is used to create, administer, score and 
report contests.  Picture submission through the website is not described in this manual.

Note that this manual is not updated as often as the program and may not exactly represent the 
current version of the program.

Installing and Uninstalling PhotoContest Pro

Installing

The initial installation is done from the PhotoContest Pro website.  When Updates are available the 
program will notify you and you can install the updates without going back to the website.  You should 
always update the program when new updates are available.
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To install PhotoContest Pro for the first time, go to:  http://www.PhotoContestPro.com/.
On the website, click on the downloads menu item and follow the instructions.  When installed, there 
will be an icon on your desktop.

Uninstalling

PhotoContest Pro does not install anything in the Program Files folder or in the Registry.
To completely remove the program, delete the folder “Moskowitz Consulting Services, LLC” and its 
contents from your Documents folder. Also delete the desktop shortcut pointing to PhotoContest Pro.
If you wish to delete all of the data (contests, pictures, etc.) that PhotoContest Pro maintains, delete 
the folder “PhotoContestPro4” from your Documents folder.

Obtaining the Latest Updates

The program will automatically check for updates every time that it is started, provided that your 
computer is connected to the internet.  

You can also ask the program to check at any time using the
Reload button on the Startup screen.

If there are updates to the program, you will be notified with a
pop-up dialog.  By clicking on the “Yes” button in the dialog you
will install the updates and the program will restart.

It is STRONGLY recommend that you install updates whenever they are available.

Getting Help

The latest version of this manual is available through PhotoContest Pro by clicking on the menu item 
Help->User Manual. If your question isn’t answered in this manual, feel free to contact the developer:
Jack Moskowitz
Moskowitz Consulting Services, LLC
jackmos@optonline.net
(973) 584-3697

We are also interested in suggestions for improving the program. All suggestions are welcome, 
however not all suggestions can be implemented.

The User Interface

On the left is a row of buttons that select various screens. Illustrated on the right is the Startup screen 
– the first screen displayed.  On the bottom is a status bar that displays information as the program 
runs. The current screen name is displayed
on the left.  Refer to this when requesting
help or reporting errors. If any errors have
occurred a red indicator is displayed with the
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text of the error message to the right.. The text of the error message only remains on screen for 10 
seconds. After that, or to get the history of errors, click on the error indicator for a pop-up window.  
Other information will be displayed as appropriate.

As you click on the various buttons and menu items different screens will be displayed.

The Local Database

PhotoContest Pro keeps a database on the PC containing the data it needs to operate.  This database
is refreshed from the server when the program starts.  You can see the progress on the Database 
block of the Startup screen.  You need to be connected to the internet to update the database, but 
once the database is stored on the PC, internet connectivity is no longer needed.  You can refresh the 
database at any time by clicking on the Reload button.

Initial Setup

Before you start using PhotoContest Pro, you should set some things up.
When the account for an organization is set up, a single user is added.  That user is the initial 
Organization Administrator (OrgAdmin).  The OrgAdmin is responsible for adding other users who may
or may not also be OrgAdmins.  In order to proceed, you will need to obtain your password and log 
into PhotoContest Pro. On the Setup screen, click the link “Click to Retrieve Password” and follow the 
instructions.  Your password will be emailed to you.  Enter your email and password and select your 
organization.  When all the information is correct the Current User Profile block on the Start screen will
show your information and you are logged in.  Note that you need to be connected to the internet to 
set or change your password, but once you've done that you can log in without being connected to the
internet.
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Workflow Summary
Before we get into details of all the features, we’ll present a typical workflow.
For details and for other features, see the rest of this manual.

• Set Preferences
• Add your users
• Create contest
• Upload the contest with the server so it is available to your photographers
• Photographers submit their pictures
• Download from the server to bring the pictures to the PC
• Set up the scoring keypads (if you are using them)
• Run and score the contest
• Create reports
• Create an End of Season contest

The following sections will describe each of these tasks and others in detail.
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Preferences
The Preferences screen is divided into four categories: General Preferences, Contest Default, 
Photographer Classes, and Server.  You set preferences by clicking Preferences button on the left 
side of the screen. On the Preferences screen there will be four tabs that you can click on, one for 
each category.

General Preferences

Clicking on the Set All Preferences to Their Default Values button on the lower left will reset all the 
values to the system default settings.

Some of the preferences are marked with “Recommended”.  You should have a very good reason to 
change these from their default values.

Constrain Pictures to Square when Scoring - Pictures are constrained to fit into the largest 
displayable square area available. It is STRONGLY RECOMMENDED that this option be selected. 
This mode emulates a slide projector and does not give an unfair advantage to pictures with 
landscape orientation.

Constrain Pictures to Square when Reviewing - Pictures are constrained to fit into the largest 
displayable square area available. If this mode is not checked the picture is displayed as large as 
possible. 

Captions within Image Area - When this is checked, the captions will be constrained to be within the 
square area that pictures are displayed in. If it is not checked then the captions will be moved out to 
the edges of the display area. This is most useful if the projection screen is square and the projector is
adjusted to fill the screen with the pictures.

Scoring Caption Display Time - This is the time that the picture captions will remain on the screen 
when scoring a contest. Note that captions can be displayed or hidden manually by typing “T” when 
scoring.  If the scoring caption display time is set to 0, then the caption will not be displayed when the 
picture is displayed.  You can display the caption as usual by typing “T”.

Page 7



PhotoContest Pro Version 4

Reviewing Caption Display Time - This is the time that the picture captions will remain on the screen
when reviewing a contest. Note that captions can be displayed or hidden manually by typing “T” when 
reviewing.

Slideshow Auto Advance Time - This is the time interval between pictures when running a slide 
show with auto repeat selected.

Show Contest Intro Screen when Scoring – When this is checked an introductory screen is 
displayed when scoring.  This displays the organization name and the contest name.

Show Contest Intro Screen when Reviewing – When this is checked an introductory screen is 
displayed when reviewing.  This displays the organization name and the contest name.

Show Score Intro Screen when Reviewing – When this is checked an introductory screen 
displaying the score or award is displayed before each group of pictures with the same score or 
award.

Enable Judging Timer/Judging Timer Timeout - This displays a count-down clock when judging 
time needs to be monitored. Use with discretion.

Show Score Distribution on Review Screen – Displays a histogram of the scores on the review 
screen.

Use Second Monitor for Scoring - For those people with dual monitors (or the projector connected 
to the second monitor output on the computer), setting this option will display the images on the 
second monitor during scoring and reviewing. This option is ignored if your computer doesn’t support a
second monitor. A second monitor is definitely not necessary to use all of the features of PhotoContest
Pro. In order for this to work,  the Windows display settings must have the second monitor positioned 
to the right or the primary monitor.   The scaling factor must be the same for both monitors. You should
also pay attention to the resolution settings of both monitors.

Require Enter Key on Keypads - If checked, allows multi digit scores and a score is entered when 
the Enter key is hit. If not checked, then the score is entered as soon as a number key is hit, limiting 
scores to 0-9.

Keypad Scoring Mode - Specifies whether to total the judges’ scores or use the average. We 
recommend using the average as it eases comparing scores across contests where the number of 
judges may be different.

Ignore Zero Scores on Keypads - When using keypads, if a judge enters a zero, then his score will 
not be considered. The total or average score will be adjusted accordingly. This is useful if a judge has
a picture in the contest and should not judge that picture.

Hide Individual Judges Keypad Scores - Hides the scores of each judge when using keypads and 
only shows the combined score when checked.
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Status Display Time - The time that the status display on the lower right is visible.

Show IDs for Debugging – this causes some internal identifiers to be displayed.  This is only useful 
when debugging or reporting problems.

Contest Defaults

This screen allows you to set up default values for new contests that you create.  You can override 
these values on each contest individually if necessary.

Of particular interest is the maximum size value.  This limits the size of submitted pictures.  The value 
represents the larger of the horizontal or vertical pixel dimension of the submitted picture.  This should 
be set to the vertical resolution of your projector or a bit bigger.

You should also set up the names of the awards that you will be assigning to the winning pictures.

Photographer Classes

Many organizations have photographers in different classes.  By setting up the classes on the screen, 
you can limit which contests each photographer can submit pictures into.  Typical classes are “A”, 
“Salon”, etc. Before you can assign your photographer to some classes, you need to define them here.

Note that if you've set up classes and assigned them to photographers and then remove one or more 
of those classes on the preferences screen, the classes will also be removed from the photographers 
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as well.

Server Preferences

Generally, you should not change these settings. However, if you routinely get timeouts you should 
increase the Timeout value.

User Maintenance
The first thing the contest coordinator needs to do is create accounts for all the club members that will 
be submitting pictures. Click on Edit Users on the left side of the screen. This screen is used by an 
organization administrator (OrgAdmin) to edit the users (photographers, contest coordinators and 
administrators) for the organization. The list of existing users is shown on the left and the fields to add 
and edit users are on the right. You can use the Sort By, Show and Search selections to more easily 
find existing users. Select an existing user by clicking on the list on the left. Create a new user by 
clicking on the New button. Delete an existing user by selecting that user and clicking on Delete. Be 
sure to click the Save button to save your changes. You must be connected to the internet to edit 
users.  Administrators can also set and display the user's password.  This is useful if the user cannot 
receive the system generated email due to spam filtering.

Can Submit Pics should be selected for users that can submit pictures to the server. Unchecking this 
may be useful at the end of a season until people pay their club dues for the next season.

Can Sync should be selected only for users within your organization that will be setting up or running 
contests and therefore need to perform the synchronization with the server. 
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Org Admin is selected only for users within your organization that will be editing the users or 
performing other administrative tasks. If the user will only be submitting pictures do not select either 
box. He does not need to use PhotoContest Pro to submit to the server. Note that you must be 
connected to the internet to edit users and that you are editing the users directly on the server.

You can also select which class or classes of contest the photographer can enter.

It is also possible to import users from an Excel spreadsheet.
Here are the requirements for that:

• PhotoContest Pro accepts .xlsx (preferred), .xls, and .csv (least preferred) formats.
• There should be only one sheet in the file.

Data sheet columns
• The first row must be the column headers.  Column headers are not case sensitive.
• Required Columns:  FirstName, LastName, Email.
• Optional Columns:  Phone, CellPhone.
• Other columns are ignored.

Data Rows
• Values in required columns must not be empty.  Values in optional columns may be empty.
• Duplicate entries are skipped.  Duplicates are defined as having the same email. Because of 

this, there is no harm in running the same Excel file multiple times.

Click the button “Select Excel File” on the upper left to select the Excel file and import the profiles.

Creating a Contest
This section will guide you through the procedure for creating a contest.
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On the left side of the screen, you will see a list of contests that are already saved on your PC. In the 
center of the screen are the fields to complete to set-up a new contest or modify one that already 
exists. On the right you will see a box for Contest Awards. This is where you will specify the awards 
that may be assigned to the pictures in the contest that you are creating.  Also on the right are the 
buttons to perform the various tasks.

If you are creating a new contest, click on the New Contest button. If you want to modify the 
information for an existing contest, click on the contest on the left to select it.

Fill in the Contest Name, Contest Date, and Final Entry Date. Filling in the Judges is optional. The 
Contest Date is the date that the contest will be judged. The Final Entry Date is the last date that 
people may enter their pictures. The Final Entry Date must be the same or before the Contest Date. 
Midnight on the Final Entry Date is the last date that your photographers can submit pictures.

Any notes that you enter in the Contest Notes box will appear on the Picture Upload screen on the 
web and should contain any special instructions for your photographers about this contest.

Note that you may have more than one contest with the same name, even with the same date 
(though this would be confusing). Typical contest names might be “July Open Class A” or 
“Assigned Subject Waterfalls”.

If your club or this specific contest assigns different awards than shown on above, you can change 
these.  Enter the award names, one on a line, in highest to lowest order. 

You can specify the maximum and/or minimum picture size that is allowed for a contest. This 
corresponds to the longest pixel dimension of the picture. If you set the maximum or minimum to zero 
then it is not checked. You can set the maximum and minimum the same to force a specific size This 
will usually give the best results. In any case the maximum allowed width or height is 2000 pixels. If 
you check the Shrink Oversize Pictures on Upload checkbox then oversize pictures will automatically 
be resized to the maximum size. We don't recommend this.  You should instruct your photographers to
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size their own pictures appropriately.  Image processing software will do a much better job of resizing 
than PhotoContest Pro can do with this option. The minimum and/or maximum picture size that you 
specify here is displayed on the Submit Pictures web application.

If you have assigned classes to your photographers, you may select which class(es) of photographers 
may enter this contest.

There is a tab labeled Multi-Organization Contest Information which will be described later.

When you have completed all the contest information, click Save Contest. The contest will be added to
the list on the left side of the screen. Changes you make on this screen are not saved unless you click 
Save Contest.
Many organizations run several contests on the same day with the only difference being the name of 
the contest. To make creating these faster, there is a Clone Contest button which will allow you to 
create a new contest which is the same as the currently selected contest but for which you can supply 
a different contest name.

If you have a lot of contests in the list, but you are only interested in seeing a small list (like the ones 
that you might be scoring at a particular time), you can limit what is shown in the list by entering a 
Filter value on the upper left.  Click on the “?” for details on how this works.

In order for your photographers to be able to submit pictures through the web, you need to put these 
contests on the server.  This is done with the Synchronization screen that you can get to with the Sync
w/Srvr button.

Synchronization
Synchronization is the process where you can copy contests and pictures from the PC to the server 
and from the server to the PC.  The ONLY purpose of having a contest on the server is so that your 
photographers can submit pictures to that contest. Scored contests and contest results are not on the 
server.  Contests and pictures on the server are automatically deleted about a week after the contest 
date.
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The main part of the screen shows a list of contests that can be synchronized.  Contests that have 
been scored and old contests do not show up on this list.  Contests where the pictures on the server 
differ from those on the PC or where the contest exists only on the server or PC are bold.  These are 
the contests that may need attention.  You should select the contests that you want to synchronize by 
clicking in the checkbox or anywhere on the entry.  New with version 4 is the ability to synchronize 
multiple contests at once.  On the right side of the screen are the command buttons.  Only those 
buttons whose commands are allowed depending on what you've selected will be enabled.  
Synchronization of contests and pictures is done separately – you must have a contest at your 
destination in order to copy pictures to it.

If you've already copied a contest to the server and want to make changes like the dates or titles, you 
can upload the contest again.  Uploading and downloading overwrites the target contest.

If you've just created some contests on the PC, the typical operation is to select those contests, then 
click the Upload Contest Info button.  This will put the contests on the server and your photographers 
will then see them on the web and be able to submit pictures.

On the upper right of the Sync screen is an info box showing picture counts and the number of 
pictures that are eligible to be moved.  Pay particular attention to the “Pictures to Upload” value.  If this
is non-zero it may mean that one or more pictures that you have previously downloaded have been 
deleted on the server by the submitting photographer.  If so, it is important that you also delete these 
pictures from the PC.  The last button Delete Pics on PC if not on Server can be used to do this.

You can delete a contest and all of its pictures from the server by clicking on the Delete Contest & 
Pics on Server button, but it really isn't necessary.  About a week after the contest date, these contests
will be deleted automatically.
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Submitting Pictures
Once the contests have been synced to the server, your photographers can submit pictures to these 
contests.  This is done through the website and is not described here.

Collecting the Submitted Pictures
After the contest Final Entry Date and before the Contest Date you should go back to the Sync screen 
and download the pictures into the contests on the PC.  Select the contests on the main part of the 
screen and click the Download Pictures from Server to PC button.  The contest is now ready to be 
scored.

If you need to add or delete pictures or change any information about any of the pictures, you can do 
so on the Contests screen after clicking on the Pictures button in the center.  You can add and delete 
pictures, change the photographers name or picture title here.

Note that you cannot add or delete pictures if a contest is scored.

Multi-Organization Contests
Organizations sometimes host a contest that allows entries from a number of other organizations 
within your group of organizations. The group of organizations that your organization is part of is 
maintained by the author of the program. If you need your group list changed, please contact the 
author.

PhotoContest Pro has two mechanisms that can make running multi-organization contests easy. The 
first mechanism allows members of all the organizations to submit their pictures directly. We will call 
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this Direct Submission. The second mechanism provides more control over the submission by 
having each organization collect the images into individual contests and then having the contest 
coordinators for each of the organizations submit all the collected pictures to the hosting organization’s
contest. We will call this Moderated Submission. Both of these scenarios are described here.

The hosting organization should create the contest as described above.  Then go to the Multi-
Organization Contest Information tab on the Contests/Contest Info screen.  You will see two list of 
organizations with checkboxes.

Direct Submission

For Direct Submission where the photographers from other organizations can submit pictures, you 
would check those organizations in the Orgs whose members can submit pictures block.  Make sure 
that no checkboxes are checked in the other block.

Save the contest and sync to the server normally.

Photographers in all the organizations you've specified will be allowed to submit photos.

Moderated Submission

For the more common Moderated Submission where each organization collects and reviews the 
pictures before being transferred to the hosting organization, the hosting organization would check 
those organizations who will be submitting pictures in the Orgs whose administrators can transfer 
contests block.  Make sure that no checkboxes are checked in the other block.

Each organization submitting pictures should set up a contest to collect pictures from their members. 
Set the Final Entry Date early enough to allow time to transfer the pictures to the hosting organization 
before the Final Entry Date of the hosting organizations contest. Once the pictures are collected, the 
contest coordinators of the other organizations should review the pictures to make sure they meet the 
rules of the contest and delete any that do not. Go to the Contests screen and click on the menu item 
Tools->Transfer Pictures to Another Contest on Server, select the contest and transfer the pictures.

Running a Contest
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PhotoContest Pro supports optional multiple keypads for judging. Each judge has his own keypad and 
enters the score directly. PhotoContest Pro totals the judges scores and records the total. Before 
using keypads, they must be set up. If you have keypads attached (usb or Bluetooth), then you’ll see a
large button on the Startup screen labeled Set Up Keypads which will bring you to the Keypad Setup 
Screen.

Click with the mouse to select a keypad (or the main keyboard) and then hit a key on the 
corresponding device. Once all the keypads have been initialized, you can use the keypads for 
scoring.

The Require Enter checkbox is described under Preferences previously.

Before you actually start to run the contest, it is a good idea to set up the projector so that the pictures 
will display well on the screen. PhotoContest Pro can display an image of the square area that the 
pictures will be constrained to. Display this square with the View->Focus and Alignment Screen menu 
item. Adjust the projector so that the square displays the way you want it on the projection screen. The
Focus and Alignment Screen also contains a grayscale bar that may be used to check or adjust the 
brightness of the projector. Hit any key or click with the mouse to dismiss the focus and alignment 
screen.

Click the Contests button on the left to get to the Contests screen and then Score Contest in the 
middle to begin scoring the contest.
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The Run Contest screen will appear. The list of available contests will show on the left. Select the 
contest that you wish to run and click on the Score Contest button in the center to go to the 
ScoreContest screen.

When running a contest, pictures are displayed in a mathematically random order. This order is 
maintained throughout the running of the contest. It will reset when pictures are added or deleted, but 
once the contest starts, the order is fixed.

Contest Scoring

Scoring a Contest

PhotoContest Pro is designed to be very flexible in the way it handles scoring to allow for the different 
ways that camera clubs score their contests. Scores may be numeric (integers like 7 or 21) or 
fractional (8.5). In addition, pictures may be assigned customized awards (“First Place”, “Third Place”, 
“Award of Merit”, etc.). Awards have a higher “value” than numeric scores.  Scoring is done in rounds. 
Typically, in the first round, a numeric score is given to each image. If necessary, additional rounds 
may be done to rank pictures with the same score from a previous round (breaking the tie). 
Sometimes, especially late in a contest, a judge will want to go through a group of, say pictures scored
8, and do a keep or discard. You could assign a numeric score of 1 or 0 to do this. Remember that the 
score from the previous round is still an 8 and this won’t change. At any time, a picture can be 
assigned an award instead of a numeric score.

When using multiple keypads, you can specify whether the score is the average of the individual 
judges’ scores or the total. We recommend using average as it makes comparing scores across 
contests easier if the number of judges changes. You can change this on the Preferences screen.
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When scoring (or displaying in Slide Show mode), the screen only shows the picture and annotations 
and the cursor is invisible so as not to distract from the pictures. Operations (scoring, displaying the 
next or previous image, etc.) are handled by hitting keys on the keyboard. You can get a popup 
displaying these keys by hitting the H key. The popup allows you to print a reference – you should do 
this before running a contest until you have the keys memorized. The keys are:

Picture Scoring Keys        
Key Function

Esc Cancel

H Show this help

Numbers Score picture

A Assign award to picture

D Disqualify picture

Backspace Backspace/Erase score

T Show/Hide picture title

Enter, Space, Right-Arrow, Down-Arrow Next picture

Left-Arrow, Up-Arrow Previous picture

V Show/Hide picture thumbnails

We will now illustrate an example of scoring a contest. 
We will be doing this using the default settings. 
To change the settings, Select Edit->Preferences. Detailed instructions on the settings are found in 
Customizing PhotoContest Pro. 

Select the Score Contest button. 
You’ll see a list of the current scores and a count of the number of pictures with each score sorted by 
score. 

Click the Score button to score the pictures.
Scoring the contest can be done using any numeric scoring system that the club chooses. When the 
picture appears on the screen, the judge usually calls out the score and the keyboard operator types 
it. If you are using keypads, then a score is entered on each keypad and when they are all entered, 
they will become visible. You can also assign an award to a picture at this time by typing the A key and
specifying the award. The number will appear on the screen. If the number is correct, hit the space bar
or enter key and the next picture will appear. Repeat until all of the pictures are scored.
When scoring a round begins, you must complete the scoring of all the selected pictures to close out 
the scoring. You will not be able to score another round until every selected picture is scored. If the 
contest is interrupted at any point, it will resume where it left off when you restart.
When scoring is complete, the Run Contest screen reappears with a summary of the scores. In a 
typical contest there are usually multiple pictures with the same score after the first pass. In 
PhotoContest Pro, you can repeat the scoring process as many times as necessary to score the 
contest. In the Demo Contest a scoring range of 5 to 9 is being used with 9 being the highest possible 
score.
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In this example, we have 9 pictures in the “January Open A” Contest. After the first round of scoring, 
we have four with a score of 9, ten with a score of 8, and a number of lower scores including one 
disqualification.

Re-Scoring

At the end of each pass, it is still possible to correct a mistake by clicking the Fix Score Error button in 
the row containing the picture(s) that need correcting. The scoring will repeat for the group of pictures 
but this time the existing score is displayed. If a score is incorrect, backspace over it and then enter 
the correct score or award. You should only use the Fix Score Error feature to fix mistakes.

Additional Passes

To break ties within group of pictures with the same score, click again on the Score box in that row. 
The pictures will reappear and can be scored again. Each time you repeat the scoring process for a 
group of selected pictures, the new score will appear after the original, separated by a comma. Note 
that you are not changing the existing score, you are adding to it. In this case we made a second pass
at the pictures that scored an 9 on the first round and now have one with a combined score of 9,9, and
two with a combined score of 9.8. You can use scores of 0 and 1 for “in” and “out”. 

Page 20



PhotoContest Pro Version 4

Different scoring systems can also be used. PhotoContest Pro will group all pictures with identical 
scores together in one row on this screen as illustrated above. 

When using keypads for scoring, instruct the judges not to hit the NumLock key if there is one. This 
will often disable the sending of the numbers. If the keypad suddenly seems not to work, hit the 
NumLock key again and this will usually restore functionality.

Assign Award

When the judge is ready to assign awards, click Score on the row containing the picture(s) that you 
want to assign an award. The pictures in that row will appear on the screen in scoring mode.
To assign an award, type a when the picture is shown instead of a number. The options for awards will
appear in the upper right corner. Type the number corresponding to the award. For example 1= First 
Place. Since you must apply a score or award to each picture in a pass, if you don’t want to assign an 
award to a picture, assign some numeric score, say 0 instead.
Hit the Space or Enter key to move to the next picture.

It is also possible to assign an award directly from this screen without repeating the scoring process. 
For example, one picture had a score of 9 and will be assigned first place. Click on Assign Award in 
that row and then select the Radio button for First Place, then click Assign Award. This can also be 
done if all of the pictures in the row will be assigned the same award such as Honorable Mention.

As you near the end of a contest, the judge may want to select and assign awards from a small set of 
pictures. This is facilitated with the v key. This shows all the selected pictures as thumbnails at the 
bottom of the display. You can click on these with the mouse to show the picture full size and you do 
this in any order that the judge wishes. Hitting the v key again will hide the thumbnails. Note that in the
thumbnail display mode, the area for the full sized picture is reduced to make room for the thumbnails.

The scoring process is now complete.
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Print Competitions

PhotoContest Pro can be used for print competitions.  Photographers would submit digital photos 
corresponding to the prints that will be judged.  PhotoContest Pro can then be used for the scoring 
and display in a large room.  Before the competition is scored, you could print out a list or spreadsheet
of the pictures.  This would be used to arrange that the physical prints are ordered the same as the 
digital pictures in PhotoContest Pro.

The issue that comes up is that PhotoContest Pro randomizes the order of pictures and reorders when
you least expect it.  This is by design.  In order to have the order of pictures when scoring the same as
the previously printed list you have to understand two “rules”:

1. Reordering will not occur if any picture in a contest has a score.
2. Reordering will not occur while you are on the Score Contest screen.

So, a useful procedure is:
1. Collect all the pictures for the contest as usual.
2. Score any picture.  Any score will do; any number of pictures including 1 will do.
3. Print the list of pictures being sure to select “Display Order” as the sorting option.
4. If not already done, copy the contest to the PC that will score the contest.

When you are ready to score the contest for real:
1. Go to the Score Contest screen.
2. Click on the Clear all Scores button.  Do not leave this screen.
3. Score the contest as usual.

Reviewing a Contest

A typical contest will end with a viewing of the winning pictures in reverse score order with the 
photographer's name and the award displayed.  This is accomplished by clicking the Review Contest 
button.
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Several display options may be selected on the right side of the screen.

Sort By is typically set to display the pictures in reverse score order. Note that awards are considered 
higher scores than non-awards. This is typically what is done after scoring a contest is completed.

You may also check the boxes to annotate the display with the Title, Photographer, Organization, 
Award and Picture Number. The Organization display is useful for multi-organization competitions. 
Note that these annotations display for a predetermined length of time and then disappear. This time is
set under Preferences. If you wish to re-display the annotations, type the T key. This acts as a toggle –
hitting it once will display the annotations, hitting it again will hide them.

You can also elect to show the Contest Intro and Award Intro Pictures.

You can also select Auto Advance for an automated slide show. The slider will adjust the timing. The 
auto repeat option will repeat the slide show until you exit manually with the escape key.

Select those pictures that you want displayed by checking the boxes to the right of the Count Column. 
You can also select all rows with awards by clicking Check Awards at the bottom of the screen, or you 
can select all groups by clicking on Check All.

Click Review Contest on the right and move through the pictures.

Hit the space bar to move to the next picture if auto-advance is not selected.

Select another contest on the left to begin the next contest.

Reports and Charts
After running one or more contests you can get various summary reports and charts. Currently there 
are five reports and four charts:

• All Contests Summary
• Pictures by Photographer
• Contest Report
• Photographer List
• Photographers by Class
• Awards by Photographer (chart)
• Success by User (chart)
• Average Score by Photographer (chart)
• Score Distribution (chart)

To create a report or chart click on the Reports or Charts menu button on the top and select the report 
you would like.

Reports can be printed or previewed on the screen. They may also be saved as text or an Excel 
spreadsheet.
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The Contest Report is only available if you have selected a contest.

Charts are available from the menu item Charts.

End of Season Contests
Some organizations do a contest at the end of the season with pictures that are collected from earlier 
contests. PhotoContest Pro has a feature that can automate this.

First, set up the end of season contest just like any other contest. Do not synchronize with the server 
as you do not want users to add pictures themselves.

On the menu, click on Tools->End of Season Contest and you will go to a screen that will collect the 
pictures for the contest. On this screen, select the contests from which you wish to collect pictures and
the scores for the pictures to include.  You can check the picture classes checkboxes to help in your 
selection. Select which contest will be the end of season contest. When all this is done, click on the 
Copy Pictures button and your pictures will be copied to the contest you have selected to be in the 
End of Season contest. Your End of Season contest is ready to run.

Additional Features

Award Certificates

PhotoContest Pro can create award certificates.  Only people with CanSync or OrgAdmin permission 
can do this.  Select a contest and click on the Contest Award Certificates button.  You will be able to 
choose the certificate background and which elements to include on the certificate.  You will also be 
able to pick which awards and scores to created certificates for.  Picture titles, score names, the 
contest name, and the organization name can be changed if necessary.  You can specify the output 
folder where the images will be deposited.  Click on Create Certificate Files to create the files.  These 
files can then be printed in whatever way is convenient.

Saving and Loading Packages

PhotoContest Pro has some features useful for managing the files, information and pictures that make
up the contests. 

First, you might be interested in knowing where PhotoContest Pro keeps the pictures and information 
about the contests. If you back up the files on your PC (which you should do as computers do crash), 
you’ll want to be sure to back up these files. PhotoContest Pro puts all of the information that it 
maintains in a folder called PhotoContestPro4 in your Documents folder. Be sure to back up this 
folder. Other than backing up this folder, you should not directly modify any of the files or folders within
this folder.
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You can copy a contest to another PC. For example, if the PC that you use to collect pictures is not the
one that the contest will be run on, PhotoContest Pro has a feature that enables this. Click on the 
menu item File->Save Contests as Packages (you can use the keyboard shortcut Ctrl-S) and you will 
be asked to specify a file to save the contest in. The file will have an extension of .pcpPkg. Once the 
contest is saved, you can copy it to another PC, email it to another person, save it somewhere as an 
archive, or do whatever you need to do with it. You can save multiple contests at the same time with 
File→Save Contests as Packages (Ctrl-Shift-S). To load a saved contest into a PhotoContest Pro 
contest with the same name and other information, click on the menu item File->LoadContests from 
Packages (you can use the keyboard shortcut Ctrl-O) and follow the instructions. If you want to load 
the pictures into an existing contest, go to the Edit Contest screen and click on the menu item File-
>Load Contest from Package Into Current Contest and follow the instructions.

Saving contests as packages is also a good way to archive old contests.

Exporting Pictures

PhotoContest Pro can export the pictures in a contest to another folder. When you do this, you are 
given the opportunity to customize the naming of the files.

To export pictures, first select a contest and then click on the menu item Tools->Export Pictures to 
Folder. You will be presented with the following screen:

Select the parts of the filename from the dropdown listboxes. You must specify at least one. Your 
settings on this screen are remembered for the next time. You can reset your settings to the system 
default by clicking on the Reset button. You will then be presented with a dialog where you can specify
the folder to export your pictures to. Once you’ve made that selection, click on the Export button and 
the files will be exported. 

Note that files will be overwritten if the name is the same. It is very possible to miss files during the 
export depending on your selection of the parts of the filename. For example, if you only specify the 
photographer and title, and the photographer has two pictures with the same title, then only one will be
exported. Consideration of the circumstances and careful selection of the filename parts will insure 
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you get what you want. 

Slideshow, Contest Results and Image Gallery Pages on Your 
Club Website

We now have a mechanism where you can have a rotating slide show, an image gallery and a contest 
results page on your website with very little code. This code is supplied to you by PhotoContest Pro.
A demo of this is on the PhotoContest Pro website (see the links at the bottom of the home page).

To put the images on the website, click on the Manage Club Gallery button on the Contests screen.

You would select a contest and the scores and then click on Start Upload. To delete pictures from a 
contest already submitted, go to the Delete Pictures on Club Website tab and click the “X” next to the 
contest name.

To create the web pages on your club website, click on Tools->Club Gallery Information. You’ll be 
presented with a page that has code for two sample html pages. You can take them as is or modify 
them to match the look of your website. Note that this code is customized for your organization. Put 
these pages on your website and you’re up and running.
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All the pictures and information is actually stored on the PhotoContest Pro server. We may impose 
limits on the space that you can use depending on how much space is available on the server.
Note that this service is not turned on by default.  You should request it if you want to use it.
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License Agreement
PhotoContest Pro License Agreement

PhotoContest Pro is protected by Federal Copyright Law.  Moskowitz Consulting Services, LLC retains
the title to and ownership of PhotoContest Pro. You are licensed to use PhotoContest Pro on the 
following terms and conditions: 

LICENSE - The licensee is defined as the individual, camera club or organization utilizing the Software
Product.  Moskowitz Consulting Services, LLC hereby grants the licensee a nonexclusive license 
authorizing any and all members of the organization to use the enclosed Product for use within the 
organization only. Use of PhotoContest Pro by anyone other than the licensee or use outside of the 
organization terminates, without notification, this license and the right to use PhotoContest Pro.

INTENDED USE: - PhotoContestPro is intended for use by camera clubs and small organizations 
running photo contests.  Large organizations or users with other intended uses should contact 
Moskowitz Consulting Services, LLC.

YOU MAY NOT: Distribute, rent, sub-license or otherwise make available to others the software or 
documentation or copies thereof, except as expressly permitted in this License without prior written 
consent from Moskowitz Consulting Services, LLC. In the case of an authorized transfer, the 
transferee must agree to be bound by the terms and conditions of this License Agreement.

RESTRICTIONS: - You may use PhotoContest Pro in your business as long as:
The software serial number and user must be registered with Moskowitz Consulting Services, LLC in 
order to receive support or distribution rights.
You may not remove any proprietary notices, labels, trademarks on the software or documentation. 
You may not modify, de-compile, disassemble, reverse engineer or translate the software.

US GOVERNMENT RESTRICTED RIGHTS - Use, duplication or disclosure by the United States 
Government is subject to restrictions as set forth under DFARS 252.227-7013 or in FARS 52.227-19 
Commercial Computer Software - Restricted Rights.

TERM - You may terminate your License and this Agreement at any time by destroying all copies of 
the PhotoContest Pro and PhotoContest Pro Documentation. They will also terminate automatically if 
you fail to comply with any term or condition in this Agreement.

LIMITED WARRANTY - This software and documentation are sold "as is" without any warranty as to 
their performance, merchantability or fitness for any particular purpose. The licensee assumes the 
entire risk as to the quality and performance of the software. In no event shall Moskowitz Consulting 
Services, LLC or anyone else who has been involved in the creation, development, production, or 
delivery of this software be liable for any direct, incidental or consequential damages, such as, but not 
limited to, loss of anticipated profits, benefits, use, or data resulting from the use of this software, or 
arising out of any breach of warranty.
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